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Disclaimer: This report is released to inform interested parties of ongoing research and to encourage discussion
of work in progress. The views expressed on statistical, methodological, technical, or operational issues are those
of the authors and not necessarily those of the U.S. Census Bureau.

This document is based on one originally developed in 2002 by Catherine Hood and Brian Monsell (and later
revised by Hood and Roxanne Feldpausch with the development of Win X-12) to assist users of X-12-ARIMA. It
explains what to do before running X-13ARIMA-SEATS. Released to the public in July of 2012, X-13ARIMA-
SEATS is a merger of X-12-ARIMA and the seasonal adjustment module of the TRAMO-SEATS program
(Gomez and Maravall, 1996), produced in collaboration with the Bank of Spain (Monsell, 2007 and 2009).

This document provides the basics of the data formats and of writing or editing a specification (command) file, or
spec file. The X-13ARIMA-SEATS Reference Manual (U.S. Census Bureau, 2016a, 2016¢) and the X-13ARIMA-
SEATS Quick Reference (U.S. Census Bureau, 2016b, 2016d) provide more details. Here we show how to create
spec files using Win X-13, the Windows Interface to X-13ARIMA-SEATS, and how to run the spec file to
seasonally adjust the series. The official version of Win X-13 is available on the Census Bureau website at

http://www.census.gov/srd/www/winx13/index.html

and is currently supported by Demetra Lytras (Demetra.P.Lytras@census.gov). Instructions on the use of this
software in this document assume that the program has been successfully installed and set up on your computer;
see Section 3 of the Win X-13 documentation (Lytras, 2016) for instructions.

This document is organized into the following topics:

1.  X-13ARIMA-SEATS Data Formats
1.1 Datevalue Format
1.2 X12save Format
1.3 Free Format
2.  X-13ARIMA-SEATS Input Specification Files
2.1 General Syntax
2.2 Creating X-13ARIMA-SEATS Spec Files with Win X-13
2.3 Details for the Series Spec
3. Running X-13ARIMA-SEATS in Windows
3.1 Single Spec Mode
3.2 Batch Mode
3.3 Options When Running in Windows
Output Overview
Indirect and Direct Adjustments
Other X-13ARIMA-SEATS Specs
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We assume the reader has a general understanding of time series, autoregressive integrated moving average
(ARIMA) modeling, and the basic concepts of seasonal adjustment. For basic information on ARIMA time series
modeling and basic seasonal adjustment, see Makridakis, Wheelwright, and Hyndman (1998). For information
about the basic methods of X-12-ARIMA within X-13ARIMA-SEATS, see Findley, Monsell, Bell, Otto and
Chen (1998). In particular, for detailed information on its X-11 method for seasonal adjustment, see Ladiray and
Quenneville (2001). For a more advanced treatment of ARIMA time series modeling and time series analysis, see
Box, Jenkins, and Reinsel (1994) or Brockwell and Davis (2002). Findley, Lytras and Maravall (2016) provides a
tutorial on the model-based seasonal adjustment method of the SEATS and its implementation in X-13ARIMA-
SEATS.

Note that there are currently two versions of X-13ARIMA-SEATS - one produces output to text files (as did
previous versions of the X-12-ARIMA program), and the other produces output in accessible HTML files. This
document covers the version that produces output to text files — another “Getting Started” document is available
on the website for the other version of the software.

1. X-13ARIMA-SEATS Data Formats

The first step in running X-13ARIMA-SEATS is to get the time series into a format the program can read. X-
13ARIMA-SEATS cannot read files from spreadsheet programs like Excel. If your series is stored in a
spreadsheet, then you need to output the series to a text file. A program called X-13-Data will help export from
Excel spreadsheets to an appropriate format. See Appendix B for more information on X-13-Data (Czaplicki,
2015a).

You have several options when deciding on a format for the series.

One option is to enter the series directly into the input file. We cover this approach in Section 2.4.

We recommend keeping each series in its own separate text file; Win X-13’s option to create a spec file works
best when the data are stored in this way. X-13ARIMA-SEATS can read several predefined formats; we will
review the datevalue format, the X12save/x13save format, and the Free format. X-13ARIMA-SEATS
supports the legacy X-11 data formats as well, which are described in Appendix C.

1.1 Datevalue Format

For most series, using the datevalue format is our suggested approach. The date is stored along with the value,
and this format is very easy to use and to read. This format can be particularly useful if you store the series in
columns in a spreadsheet. A file in datevalue format must contain only one series.

A datevalue file has three columns: year, month/quarter, and series value, separated by a tab or a space. It has
no header rows. Example 1 shows the datevalue format.

1.2 Xl2save or X13save Format
The x12save format is the format X-13ARIMA-SEATS uses to save files. The file has two columns: date and
series value, separated with a tab and it has a two-line header at the top. Note that another name for this format is

x13save; the program will accept either x12save or x13save.

Example 2 shows the x12save format.



Example 1 - Datevalue format, selected dates only:

20111 2.114
20112 2.209
2011 3 2.538
2011 4 2.935
20115 3.642
20116 4.827
20117 5.131
2011 8 5.642
20119 5.893
201110 5.406
201111 4.391
201112 2.816
20121 1.813

Example 2 - X12save format, selected dates only:

date MWBP.al

199401 +0.122470000000000E+05
199402 +0.138680000000000E+05
199403 +0.271470000000000E+05
199404  +0.295790000000000E+05
199405 +0.328030000000000E+05
199406 +0.315910000000000E+05

1.3 Free Format

Free format means that the series values have tabs, spaces, or line breaks separating the numbers. The file
contains series values only. This format does not allow additional information (for example, dates). Only one
series can be stored in the file.

2. X-13ARIMA-SEATS Input Specification Files

Once you have the data file(s), the next step is to write an input specification file, or spec file, or perhaps modify
the spec file produced by Win X-13, the Windows interface program discussed in Section 2.2. A spec file is a text
file used to specify program options. Because it is a text file, use a text-editing program, like Notepad (or the
editor within Win X-13) to create or edit the file. The file must have the extension .spc and not .txt, for example,
test.spc.

Each input spec file has functional units called specs. Each spec inside the spec file controls options for a specific
function; for example, the series spec controls options for series input, and the arima spec controls options to
specify the ARIMA model. There are 20 different specs, but the choice of some specs for a spec file excludes the
use of others in the same file. For example, when the ar ima spec is specified in a spec files, the automdl and
pickmdl specs cannot be specified. We will discuss almost all of the 20 specs to some extent in this document.

RULE - The name of the spec file must end with the ".spc" file extension.



2.1 General Syntax

Enter input in upper, lower, or mixed case. Note: If you have a "name" argument to give a name to a label in your
data file, as legacy X-11 formats require, then the name must match the label exactly, including the case. (See
Examples C.1 and C.2 of Appendix C for examples with labels.) Dates are in the form yyyy.period. For monthly
series, the period can be the number of the month or the first three letters of the name of the month. For quarterly
series, the period is the number of the quarter. So users can write January of 1990 as 1990.1 or 1990. jan
(also 1990.01 or 1990.Jan or 1990. JAN), or write the first quarter of 1990 as 1990. 1.

Enclose character values, such as titles and file names, in quotes (single or double).

X-13ARIMA-SEATS treats everything on a line of a spec file after a "#" as a comment.

You can set a variety of arguments within each spec. If you have more than one value for an argument, you must
enclose all values in parentheses. If an argument is not specified, X-13ARIMA-SEATS usually assumes a default
value. X-13ARIMA-SEATS only performs the functions you specify (or that are implied by other specs). You can
enter the arguments within an individual spec in any order.

The first spec in a spec file must be a series, composite, or metadata spec. If you have a metadata
spec, then it must be first, and the next spec must be either a series or composi te spec. After that, the specs

can appear in any order.

Every spec begins with the name of the spec and a left curly bracket, "{". Following all the arguments of the spec,
close the spec with a right curly bracket, "}".

General Input Syntax

spechame{
argumentl = value
argument2 = ( valuel value2 value3 )
argument3 = "A string value"
argument4 = 2000.apr

}

# This iIs a comment.
# 1t is not executed.

2.2 Creating an X-13ARIMA-SEATS Spec File with Win X-13

In this section, we demonstrate how to create a basic spec file with default options with Win X-13 for the purpose
of seasonal adjustment. We discuss how Win X-13 chooses the options you see in the spec file and provide some
guidance in editing them further.

From the main Win X-13 screen, select ‘Spec file’ from the Create menu. The window shown in Figure 1 will
appear. In the ‘Data file or data metafile’ box, enter the full path and file name, including the extension, of your
data file. Win X-13 will save the new spec file to the data file’s directory. Unless you change the name in the
‘Name of the new spec file’ box, the spec file will have the same file name as the data file but with a .spc
extension.

Once you select an existing data file, the controls in the ‘Spec file options’ box will be enabled. From the ‘Data
format’ box, select the format of your data file. Section 1 of this document gives a description of common data



formats. If you use free format, you must also provide the date of the first observation (in yyyy.period format as
described in Section 2.1) in the “Start date’ box.

If you use one of the X-11 formats described in Appendix C, you must give the series name in the ‘Name’ box;
recall that the name must match the label in the data file exactly, including case. From the ‘Period’ box, choose
12 for monthly data, 4 for quarterly data, and 1 for annual data. (Note that you cannot seasonally adjust annual
data, but X-13ARIMA-SEATS can model and forecast it.)
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Figure 1 - Create New Spec File Window

If the series is an inventory/stock series, check the “This is a stock series’ box on the Prior Adjustments tab.

The options described thus far are the only ones necessary for creating a spec file. This document also covers
optional settings.

When you set only these necessary options and press ‘Create Spec,” Win X-13 will produce the spec file in
Example 3. You will not see this spec file unless the input specification has a problem, such as an incorrect data
format. It provides instructions for X-13ARIMA-SEATS to run with default settings. Win X-13 runs this initial
spec file and produces from the run a second spec file containing the options selected from the first run for the
user to read and accept or change.



Example 3 - Default Win X-13 initial spec file
#C:\data\retai I\AutomotivePartsStores.spc was created on 8/31/2012 10:00:00 AM

series{
file = "AutomotivePartsStores.dat"
period 12

format = free
start = 2000.1

3

transform{
function = auto

3

regression{
variables O

aictest = ( td easter )
savelog = aictest

outlier{
types = ( AO LS )

automdI{
savelog

3

forecast{
maxlead = 12
print = none

amd

3

x11{
seasonalma = MSR
savelog = all

}

This section discusses the specs shown above; Section 4 contains a discussion on the savelog and print
arguments.

series - Specifies the location and format of the series. This is a very important spec and has several options
that depend on the form of the data. We cover this spec in detail in Section 2.3.

RULE - The series spec comes first, unless there is a metadata spec. If there is a metadata spec,
it must come first, in which case the series spec must be second. All other specs can be in any order.

transtorm - Specifies a data transformation. The most common transformation for seasonal adjustment is the
log transformation. In the Win X-13 example spec, the argument function = auto instructs X-13ARIMA-
SEATS to do a likelihood comparison to decide whether to log transform the data. With the automatic
transformation comparison, X-13ARIMA-SEATS also sets the seasonal adjustment mode. If the program prefers
the log transformation, then X-13ARIMA-SEATS will compute a multiplicative seasonal decomposition. If the
program prefers no transformation, then X-13ARIMA-SEATS will compute an additive decomposition. A spec
file created with Win X-13 will always have a transform spec. If you create a spec file without the transform
spec and specify a regARIMA model (with a regression spec and either an automdl spec or an ar ima spec
- details to follow), no transformation will be used and you must set mode=add in the x11 spec.

regression - Specifies the regression components of a regARIMA model. With the argument aictest =
(td Easter), X-13ARIMA-SEATS will test using Akaike's Information Criterion corrected for sample size
(AICC) for the presence of trading day (td) and Easter effects. For the td test, X-13ARIMA-SEATS will model
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the series with no td effects, with a six-coefficient td effect, and with a one-coefficient td effect, and will include
in the model the one that has the lowest AICC. For the Easter test, X-13ARIMA-SEATS will model the series
with no Easter and with Easter effects with a one-day, an eight-day, and a fifteen-day window, and include the
effect that yields the lowest AICC. If you know the series has no Easter effects, change the argument to
aictest = td; with Win X-13, you do this by unchecking the ‘Easter’ box in the ‘AIC test’ box of the *Prior
Adjustments’ tab. If you have an inventory or stock series, change the argument to aictest =
(tdstocklcoef Easterstock) oraictest = tdstocklcoef; Win X-13 will automatically make
this change if you check the *This is a stock series’ box on the ‘Prior Adjustments’ tab.

outlier - Identifies additive outliers (point outliers), level shifts, and temporary changes. No arguments are
required; however, by default, X-13ARIMA-SEATS identifies only point outliers and level shifts. To identify all
three types of outliers for monthly or quarterly series, also check ‘“TC’ in the “Types of Outlier to Test for’ box in
the ‘Prior Adjustments’ tab. This selection will change the argument to types = ( AO LS TC ). If you are
editing the spec file by hand, note that this is equivalent to types = all. Leaving out this spec means there
will be no automatic outlier identification.

automdl - Selects an ARIMA model and tests for significance of a constant regressor. No arguments are
required. For X-13ARIMA-SEATS and Version 0.3 of X-12-ARIMA, the automatic model identification
procedure is based on that of TRAMO, whose main details are described in Gomez and Maravall (2001). If you
would like to use the procedure of earlier versions of X-12-ARIMA, picking a model from a stored list of models,
use the pickmd1 spec instead of the automdl spec. Users must specify the pickmdl spec manually; Win X-
13 does not support the pickmdl spec. Omitting automdl could cause problems if you are trying to fit a
regression model or search for outliers unless you specify an ARIMA model explicitly with the arima spec
(details on arima later in this section).

forecast - Generates forecasts from the estimated regARIMA model. Without a forecast spec, in the
presence of a regARIMA model and an x11 spec, X-13ARIMA-SEATS will forecast one year ahead. (If the
automatic model identification procedures of automdl or pickmdl cannot find an acceptable model, then the
program does not generate any forecasts.) Without a forecast spec, in the presence of a regARIMA model and
a seats spec, X-13ARIMA-SEATS will forecast three years ahead. In the example spec above, maxlead =
12 asks for one year (12 observations) of forecasts. To change this number, select the “Number of years to
forecast’” from the ‘ARIMA model’ tab, or edit the argument manually. The argument maxlead = 24 will
cause X-13ARIMA-SEATS to forecast two years ahead for a monthly series while maxlead = 8 or maxlead
= 2 will do the same for a quarterly series or an annual series, respectively. To get no forecasts, set maxlead
= 0. In certain cases, X-13ARIMA-SEATS can backcast the series; use the argument maxback = xxx to
select the number of observations to backcast. In Win X-13, select ‘Customize Spec Arguments’ from the File
menu of the ‘Create New Spec File’ window; see the Win X-13 manual for details.

Xx11 - Generates the seasonal adjustment using X-11 seasonal adjustment methods and filters. No arguments are
required unless you omit the transform spec and use a regARIMA model, and in that case, you need to add the
argument mode = add for an additive decomposition. The argument seasonalma = MSR given in the
example spec file is the spec’s default option; it requests X-13ARIMA-SEATS to choose the length of the
seasonal filter used to seasonally adjust the series. Without an x11 or a seats spec, you will not get a seasonally
adjusted series; the seats spec is described at the end of this section.

After Win X-13 has created this initial spec file, it runs the spec file and reads the results from the unified
diagnostics file (also called the .udg file; this file is described in the X-13ARIMA-SEATS manual). It then creates
a spec file with the options hard-coded to the selected settings. Example 4 shows an example of such a spec file.
In what follows, we use the term “hard-coded” to mean that the desired options are explicitly written in the spec
file, even those that are the default options of the software.
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Example 4 - Win X-13 created spec file with hard-coded options

#c:\data\retai I\AutomotivePartsStores.spc was created on 8/31/2012 10:00:02 AM
#Created using X-13ARIMA-SEATS version 1.0 build 149

series{
file = "AutomotivePartsStores.dat"
period = 12
format = Datevalue
3
spectrum{
savelog = peaks
3
transform{
function = log
3
regression{
variables = ( td easter[15] A02000.Sep LS2001.Jan )
#aictest = ( td easter )
#savelog = aictest
3
outlier{
types = ( AO LS )
arima{
model = (0 1 1)(0 1 1)
s
forecast{
maxlead = 12
print = none
estimate{
print = (roots regcmatrix acm)
savelog = (aicc aic bic hg afc)
3
check{
print = all
savelog = (lbg nrm)
x11{

seasonalma = s3x5
savelog = all

slidingspans{
savelog = percent
additivesa = percent

}

history{
estimates = (fcst aic sadj sadjchng trend trendchng)
savelog = (asa ach atr atc)

}

Note that, with the exception of hard-coding the seasonal adjustment filter choice, running the spec with the
automatic options and running it with these choices written into the spec file will not affect the seasonal
adjustment. The main reason to fix the selections to their desired value is to keep the program from changing its
decision later when the spec file is used in production. If you want to use any settings other than the default
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selections, you will also have to hard-code the options, so understanding how to change these settings is
important.

Note that for a production setting, we recommend hard-coding selections as Example 4 shows and as described
below:

transform - Specifies a data transformation. Since the automatic transformation procedure selected a log
transformation, the initial spec’s transform{function=auto} was changed to
transform(function=01og}. If the automatic transformation procedure had selected no transformation, then
this would have become transform(function=none}. Deleting the transform spec would also result in
no transformation, but if you delete the transform spec entirely you need to add mode=add to the x11 spec if
you want an additive adjustment. When the automatic transformation test selects no transformation or if
function=none is in the transform spec, X-13ARIMA-SEATS automatically sets the seasonal adjustment
mode to additive.

If you know when creating your spec file that the series needs a log (or no) transformation, you can select ‘Log’
(or “None’) from the ‘Transformation’ box in the ‘Prior Adjustments’ tab of the Create Spec window.

regression - Specifies the regression components of a regARIMA model. If the test for trading day or Easter
accepts these variables in the model, if the program identifies any outliers, or if the constant regressor was
significant, these variables will appear in the variables argument. For example, for this series a trading day effect,
a fifteen-day Easter effect, one point outlier (or AO, additive outlier) at September 2000 and one level shift at
January 2001 were selected, and the following appeared in the spec file:

regression{ variables=( td easter[15] A02000.Sep LS2001.Jan ) }

If the AICC test had instead selected one-coefficient td, td1coef would be in the argument; for a stock series,
tdstock[31] and tdstocklcoeT[31] represent the six-coefficient and one-coefficient effects when the
inventory occurs on the last day of the month. If the AICC test had instead selected a one-day or eight-day Easter
effect; Easter[1] or Easter[8] would appear in the list of variables. A temporary change will have the form
TCyyyy.period. Note that it is usually best not to specify outlier regressors for dates whose series values may
change with later data revisions.

If you know when creating your spec file that the series has trading day effects in it and you would like to model
them, include variables = td by unchecking ‘TD’ from the ‘AIC test’ box and checking ‘Trading Day’ in
the ‘Regression Variables’ box; other forms of trading day can be added by typing them into the ‘Other variables’
box. Add Easter effects in this same way.

arima - Specifies the ARIMA part of a regARIMA model. Enter results from the automatic modeling procedure
into X-13ARIMA-SEATS with the arima spec. In this example, the automatic modeling procedure requested by
the automd I {} spec selected the model (O 1 1)(0 1 1).

In the new spec, Win X-13 specified this with the command

arima{model=(0 1 1)(0 1 1)}

Note that the new spec does not include the automd 1{} spec; only one of automdl, arima, and pickmdl
can be in a spec file. Please see Appendix A for the options to run X-13ARIMA-SEATS for some other situations,
for example, to run X-13ARIMA-SEATS as if it were X-11.



spectrum - With monthly (period=12) series, specifies a search to detect spectrum peaks associated with
seasonal effects in the differenced, transformed original series and in the regARIMA model residuals, the
irregular component, and the differenced seasonally adjusted series. It also detects peaks associated with td effects
in these last three series. It has options to specify output, change from autoregressive spectrum and periodogram
spectrum estimation, change the start of the span for the spectrum calculation, and change the method or criteria
used to identify a "visually significant” peak.

check - Generates diagnostics for the fit of the estimated regARIMA model and the significance or
insignificance of some estimated regression effects. To show all the diagnostics available with the check spec,
we added the argument print=al l. This spec has no effect on the model or model estimates, but without it, the
program computes fewer modeling diagnostics. Win X-13 always includes this spec when creating a spec file.

estimate - Estimates the regression and ARIMA models. The presence of one of the modeling specs implies
estimation of the model, so this spec is not required; however, it controls printing of the model and related
diagnostics, so Win X-13 always includes this spec when creating a spec file.

Xx11 - Generates the seasonal adjustment using X-11 seasonal adjustment methods and filters. The seasonal filter
specified by the argument seasonalma is hard-coded in the final Win X-13 spec file. In this example,
seasonalma = s3x5 results in seasonal factors from weighted averages from seven years of surrounding
values for each time point (with modifications at the series’ ends). Other filters commonly used are s3x3, often
selected when the seasonal pattern is changing swiftly, and s3x9, often selected when the seasonal pattern is
more stable or when longer averages are needed for noise suppression to support adequate estimation

slidingspans - Generates sliding spans analysis, a seasonal adjustment stability diagnostic. No arguments
are required. This spec is optional.

history - Generates "historical" diagnostic analysis of seasonal adjustment estimates and/or regARIMA model
forecast performance and AIC. With estimates=(fcst aic sadj sadjchng trend trendchng),
it generates

e Fcst: estimates of the squared one-step ahead and one-year ahead forecast errors

e aic: Akaike’s information criterion

e sadj: revisions of the seasonally adjusted series

e sadjchng: revisions of the month-to-month, or quarter-to-quarter, percent changes of the seasonally

adjusted series

e trend: revisions of the trend-cycle

e trendchng: revisions of the month-to-month, or quarter-to-quarter, percent changes of the trend-cycle.
(For additive adjustments, instead of percent changes, the program calculates differences.) If no arguments are
specified, the spec will generate estimates only for the seasonally adjusted series. This spec is optional.

The following spec is not in the example spec file but is an alternative to the x11 spec:

seats - Generates the seasonal adjustment using the SEATS implementation of the Hillmer-Tiao ARIMA
model-based seasonal adjustment methods and filters. Though there are arguments to allow users to duplicate the
functionality of the SEATS program, users need no arguments to generate a seasonal adjustment. To select a
SEATS adjustment rather than an X-11 adjustment when creating a spec file with Win X-13, select ‘SEATS’
from the ‘Type of adjustment’ box in the ‘Seasonal Adjustment’ tab. Without an x11 spec or a seats spec, you
will not get a seasonally adjusted series.
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2.3 Details for the Series Spec

The main function of the series spec is to input the time series correctly to X-13ARIMA-SEATS. It must have
either a ¥ le argument or a data argument but not both. The Fi e argument gives the name of an external
data file. The data argument lists the series values inside the spec file.

2.3.1 Data Argument

To include your series values in the spec file, use the data argument and enter the series values within
parentheses separated by spaces and line returns. The data argument does not require a specific format; Example
5 shows two years of a quarterly series on each line. With a data argument, you need a start argument to tell
X-13ARIMA-SEATS when the series starts. Win X-13 does not support this option; to use it, create or edit the
spec file manually.

Example 5 - Series spec with a data argument

series {

data=( 5.738 11.596 13.738 10.053
.033 10.025 13.637 9.600
.480 11.644 15.752 11.302

5 .120 10.394 14.261 10.188
6

6

6.948 12.251 16.350 12.129

7

6

.872 10.919 13.053 10.429
.723 12.565 15.734 10.911
.859 13.140 19.114 13.725
.974 13.523 17.722 13.215
.022 12.109 16.940 11.646 )

-593 13.954 20.139 13.501
-861 11.404 16.666 12.613
start = 2001.1
period = 4
title = "Quarterly State and Local Highways Pavement"

[e)Ne)Ne)Ne)N¢) Ne)l

}

RULE - With the data argument, a start date is required. X-13ARIMA-SEATS will compute the
rest of the dates for the series based on the start date.

2.3.2 File Argument

Updating the data argument of the series spec every month or quarter can be tedious. Another way to provide
the series to X-13ARIMA-SEATS is the Ti le argument. Section 1 discusses several predefined formats.

To seasonally adjust the series beginning at a time point later than the start date of the file, see the span
argument in Section 2.3.3.

2.3.2.1 Datevalue and X12save Formats

Examples 1 and 2 showed the datevalue format and x12save format, respectively. Recall that both
datevalue and x12save formats include dates so no start argument is used. These formats do not allow
labels inside the data file, so a name argument is not required either, but users can specify a name and if given,
will appear in some output files. Note that currently, the x12save format is now named x13save; however, the
program will still accept the name x12save. Example 6 shows how to input the file from Example 2.

Example 6 - Series spec with a ¥ le argument and x12save format

series{ file = "MWBP.al" format = "'x12save" }
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2.3.2.2 Free Format

The default format for the file argument is Free format. Recall that only the series values are in the file;
additional information is not allowed.

Example 7 - Series spec with a i le argument and free format

series{ file="example7.dat” start = 1982.jan }

RULE - With a free-formatted file, a start date is required. X-13ARIMA-SEATS will compute the
rest of the dates for the series based on the start date.

2.3.3 Other Useful Options for the Series Spec

name - Sets a short name for the series. The name argument is required with the X-11 formats described in
Appendix C. It also appears in other places, so it may be useful even if you use something other than an X-11
format.

period - Specifies the frequency of the series. The default is 12 (a monthly series), so this argument is required
only with a different number of sampling periods per year, or for noncalendar data.

RULE - For quarterly series, use period=4 in the series spec. For annual data, use period=1.

title - Specifies the series title. Titles are useful and highly recommended. The log file and output file use
titles, and X-13-Graph uses the specified title as a secondary title for graphs. With Win X-13, users can enter a
title in the *Data’ tab when creating a spec file.

decimals - Specifies the number of decimals shown in the printed output file, except for tables that contain
percentages or ratios. The default is O - no decimals. (Tables with percentages/ratios will display either 1 or 2
decimals, depending on the table.) This argument does not affect the format of files produced by the save
argument. See below for more information on saving files. In Win X-13, this option is available in the ‘Customize
spec arguments’ from the File menu.

span — Sets the time interval for seasonal adjustment. If mode l span is not set, it will also set the time interval
for modeling.

mode Ispan — Sets the time interval for modeling. This must be the same or a subspan of the span.
The forms of the arguments are:
span = (startdate, enddate)
modelspan = (startdate, enddate).
By leaving the end date blank, you can set only the start date: (yyyy.period, ).
By leaving the start date blank, you can set only the end date: ( , yyyy.period).

Or you can set both: (yyyy-period, yyyy.period).

The default span for seasonal adjustment is the entire series. The default span for modeling is the interval in the
span argument if given or the entire series if neither span is specified.
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The span and model span can be set in the ‘Data’ tab when creating a spec file with Win X-13.

type - Indicates the type of series being input. If type = Flow, the series is assumed to be a flow series; if
type = stock, the series is assumed to be a stock series. Setting the type can help users avoid conflicts in
regressor types. The default is not to assign a type to the series.

3. Running X-13ARIMA-SEATS in Windows
Once you have a spec file, you can run the program.

X-13ARIMA-SEATS is a command-line program activated by entering appropriate run information in a
Window’s command window (which can be brought up by holding the Window logo key depressed while
depressing the R key). However, it is usually much more convenient to use Win X-13, which allows you bypass
the run prompt.

Open Win X-13. From the main screen (Figure 2 below), use the box on the left to change to the directory where
you have saved your spec file.

S8 Win x-13 =B 5

File Create WView

Select input files View output files
=0 x13 ~ [%13Input ~|  |HTML Output Files |
- | data ; ;
: buildi ) ®I2 Food services and drinking places.spc Family clothing stores html -
J building permits 2 Fuel dealers soc Food and beverage stores html
| construction — T P Full service restaurants html
| etz RI2 Full service restaurants spo Gift novelty and souvenir stores
wholssals IRI2 Fumiture and home fumishings stores spc Grocery stores html
H d ) ' - Health and I stare:
- |, graphics ﬁ Fumiture home fum electronics and applianc HEEW ?nlj_.r a?-.‘edrsgoar;ﬁecs?;eresirrlerr
-y x13as it Home fumishings stores html
h T Jewelry stores html
Fl 1 P 4 r Mens clothing stores Html ~
Optiohz Wi Lpon completion:

[v* Run in graphics mode

W QOutput files
Graphics directory: |h:"-x13"-.gmphic:5"-..

[+ Diagnostics

I Mew name for spec output: |

[ Output directory: | v Graphs
[ Save original, trend, seasonal adjustment, and seasonal factors as HTML
[V Create summary file with diagnostics information

[ Verify spec
Advanced options Run

Figure 2 - Win X-13 Main Screen
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3.1 Single Spec Mode

To run the spec file, double click on the name of the file (from the middle box), or select the spec file and click on
the Run button. The box on the right lists the output files; the drop down menu directly above this box can filter
the output file types. The output file has an .out extension with the name of the file matching the name of the spec
file (without the .spc extension). The log file, a short file with requested diagnostics, has the same name as the
output file with “.log” appended to the end. You can double click on the files to open them in a web browser, but
if the “View upon completion: Output files’ box is checked then the output files will open when you run a spec
file.

To edit the spec file, either (a) right-click on the spec file name in the center box and select ‘View Input File’, (b)
or select the file and choose “View file name.spc’ from the View menu, or (c) select the file and press Ctrl+O.
Starting with the 2015 releaseof Win X-13, you can run the spec file directly from inside the spec file window by
pressing the Run button. Pressing the arrow button directly next to the Run button allows users to change certain
runtime options from the spec file window. These include the graphics directory, the output directory, and the
output name. All other options will always be run as they were when the spec file window was opened; no
changes to runtime options made on the main screen or in the Settings window are passed to the spec file window.

If you want to run X-13ARIMA-SEATS and not overwrite previous output, you can direct the output to another
file by checking the ‘New name for spec output’ box under Options. Then enter the name of the alternate output
file in the box. To save the output files to a separate directory, check the 'Output directory' box, and enter the new
directory in the text box.

3.2 Batch Mode

Besides running one series at a time, X-13ARIMA-SEATS also can run in "multiseries™ or batch mode. Running
in batch mode reduces keystrokes and provides an easier way to look at the diagnostics because the program
stores diagnostics from all the runs to the same log file. Note that batch mode also is useful for running competing
sets of options for one series; each run requires a separate spec file.

To run more than one series with one call to X-13ARIMA-SEATS, create a metafile. The metafile is a text file
with the extension .mta listing the spec files you want to run. It can list up to 5,000 spec files. To create a metafile
using Win X-13, select ‘Metafile’ from the Create menu.

To run in batch mode, double click the metafile or select it and click ‘Run.” X-13ARIMA-SEATS will run all the
spec files listed inside the metafile.

RULE - A metafile must end with the .mta extension.
Example 8 - Example of a Metafile, bps.mta
nebp
mwbp

s_bp
w_bp

If you ask X-13ARIMA-SEATS to run the metafile bps.mta given in Example 8, then it will run the spec files
nebp.spc, mwbp.spc, s_bp.spc, and w_bp.spc, and will name the output files nebp.out, mwbp.out, s_bp.out,
and w_bp.out. The name of the log file will be bps.log.
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To specify an alternate name for the output and save files, list two file names on each line of the metafile. The
first file name must be the name of the spec file, and the second file name is the name of the output and save files.
If the line lists only one file name, then the program takes the output file names from the names of the spec files.

X-13ARIMA-SEATS will not rename the log file when running a metafile. If you save the metafile to a new
name before rerunning it, X-13ARIMA-SEATS will not overwrite the previous log file.

3.3 Options for Running in Windows

When running a spec file, you can specify run-time options that affect the X-13ARIMA-SEATS output. The two
most common options are running in graphics mode and running in summary mode.

If you check the box ‘Run in graphics mode’ and designate a ‘Graphics directory’ on the main Win X-13 screen,
then when a spec file is run X-13ARIMA-SEATS will write several text files to the graphics directory containing
various tables from the output. We call these graphics files, and they are used to easily create graphs. The Census
Bureau offers a program, X-13-Graph, which can produce many types of graphs from these graphics files. There
are two versions of X-13-Graph: the batch version requires SAS (Lytras, 2015a and 2015b), though you do not
need to know how to use SAS, and the other version runs in Java (Lytras, 2013). Appendix B gives links to these
programs.

Win X-13 can produce a limited number of graphs from the output. First select either ‘Win X-13 JAVA graphs’
or ‘X-13-Graph SAS graphs’ from the ‘Type of graph to create when run in graphics mode’ drop down box on the
Settings screen. Then when a spec file is run with 'Run in graphics mode' and 'View upon completion: Graphs'
checked, Win X-13 will create graphs of the original series, seasonally adjusted series, seasonal factors, and
various diagnostic graphs and display them on the screen.

Run X-13ARIMA-SEATS in summary mode by clicking ‘Create summary file with diagnostics information.’
Summary mode means that X-13ARIMA-SEATS will create an additional output file called the unified
diagnostics file, or udg file, when it runs the spec file. X-13ARIMA-SEATS saves this file to the output directory
if you are not running in graphics mode; if you are running in graphics mode, it will be saved to the graphics
directory. The file contains a condensed version of the diagnostics and estimates contained in the output file.
Though it can be difficult to read since it contains many abbreviations, users can extract a customized set of
diagnostics. Running either in summary mode or graphics mode with the “View upon completion: Diagnostics’
box is checked, will produce a Diagnostics window with information about the model, the adjustment, and the
diagnostics (Figure 3). From this screen, go to Help -> Diagnostics List for a description of the columns.

Other run-time options found on the main screen of Win X-13 include the ability to change the output name or
output directory, which was described above, and “Verify spec,” which causes X-13ARIMA-SEATS to check the
syntax of your spec file but not actually run it. Further options can be found by clicking the ‘Advanced options’
box; see the Win X-13 documentation for more information.
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'Figure 3 - Diagnostic output from Win X-13

4. Output Overview

4.1 Controlling Printing to the Output File

Every spec (except the arima and metadata specs) has a print argument to control the tables that appear in

the output file.

You can specify a printout level.

e Print
e Print
e Print
e Print
e Print

none corresponds to no tables printed for that particular spec.

brief corresponds to a reduced number of tables printed for that particular spec.
default corresponds to printing the default tables for the spec.

al l'tables corresponds to printing all the tables but no plots for the spec.

al I corresponds to printing all tables and plots for the spec.

Users can add or remove individual tables from a print level. For example, in the x11 spec, to reduce the number
of tables in the output, you can specify a brief printout. Along with the brief output, if you want to see the
irregular component (Table D13) but don't want to see the calendar effects (Table D18), use the argument print
= ( brief +irregular -calendar )or print = ( brief +d13 -d18). To see only the
seasonally adjusted series in the output from the x11 spec, use the argument print = ( none +d11 )

For a list of all the tables with their names and codes, please see the X-13ARIMA-SEATS Quick Reference (U.S.
Census Bureau, 2016b and 2016d).
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4.2 The Log File

Every X-13ARIMA-SEATS run produces a log file. The log file contains a summary of requested modeling and
seasonal adjustment diagnostics. You control which diagnostics are saved to the log file with the savelog
arguments. If you do not request to save any log information, the resulting log file will have only series names,
titles, and for batch-mode runs, a list of runs with errors.

For a list of all the diagnostics available to save to the log, please see the X-13ARIMA-SEATS Quick Reference
(U.S. Census Bureau, 2016b and 2016d).

The name of the log file has the same name as the output file but with a “.log” extension. For example, if you
asked X-13ARIMA-SEATS to rename the output file, X-13ARIMA-SEATS will rename the log file as well.

Example 9 - Spec file with some of our favorite savelog arguments for a monthly series:

series{
file=""seriesl.dat"
start=1981.1

title="Example 9"
}

spectrum{
savelog = peaks
}

transform{ function=auto savelog=atr }

regression{ aictest=(td) savelog=ats }

automdl{ savelog=amd }

outlier{ }

forecast{ maxlead=42 }

estimate{ print=(default +rcm +acm +rts) savelog=(acc afc) }
check{ print=all savelog=all }

x11{ seasonalma=s3x5 savelog=(all) }

slidingspans{ savelog=pct }

history{ estimates=(sadj sadjchng) savelog=(asa ach) }

4.3 Saving Files

You may want to save some of the tables in individual files. For example, particularly in production with many
series, you may want to save the seasonally adjusted series or the seasonal factors.

The save argument is available for all specs except the arima and metadata specs. The save argument
causes X-13ARIMA-SEATS to write the specified tables to individual files. Saved tables are stored in files in the
same directory as the program output, with the same file name as the program output but with a different
extension. The extension is a distinct extension of up to three characters, which also serves as the table
abbreviation.

For a list of all the tables with their names and codes, please see the X-13ARIMA-SEATS Quick Reference (U.S.
Census Bureau, 2016b and 2016d).
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Example 10 — Sample spec file named test.spc that saves the seasonally adjusted series

series{
file = "test.dat"”
start = 1987.jan

}

x11{ save = seasadj }

If you ask X-13ARIMA-SEATS to rename the output, X-13ARIMA-SEATS will also rename the saved files. For
example, if you run the spec file test.spc, the output file will be test.out, and the seasonally adjusted series will be
in test.d11. If you run the same spec file, but ask to rename the output to c:\x12test\test2, then the output file will
be c:\x12test\test2.out and the seasonally adjusted series will be in c:\x12test\test2.d11. In Win X-13, the user
can change the name and directory of the output in separate input boxes on the main screen (see Figure 2).

Most saved files have two columns. A tab character delimits the columns. Dates are in the format yyyymm
(199706 for June 1997). The corresponding series values are in scientific notation to 15 decimal places. Every
saved file has a two-line header. See Example 2 for an example of a file saved in x12save format.

Note that the graphics files for the output tables are the same as the saved files, and if production runs are in
graphics mode, production systems could read these files from the graphics directory.

Win X-13 has an alternate way of saving the seasonally adjusted series, the combined adjustment factors
(seasonal combined with calendar factors), and the trend-cycle. When using Win X-13, check the ‘Save original,
trend, seasonal adjustment, and seasonal factors as HTML’ box on the main screen before running the spec file or
metafile; this will save these series to the output directory as HTML files (which can easily be opened in Excel),
creating a separate HTML file for each element.

For example, if you run airline.spc, airline_SeasAdjSeries._html will contain the seasonally
adjusted series. If you run the metafile bps.mta, then bps_Trend . html will contain the trend-cycles of all
the series in the metafile.

5. Indirect and Direct Adjustments

What is an indirect adjustment or a direct adjustment? The Census Bureau publishes Building Permits information
for four regions of the U.S. (Northeast, Midwest, South and West) and the total for the U.S. We can sum the four
regional series first and then seasonally adjust at the U.S. level (direct adjustment), or we can adjust the four
regional series first and then sum the four seasonally adjusted series to get an adjustment at the U.S. level (indirect
adjustment).

To generate both direct and indirect adjustments of an aggregated series from a set of components, you need to
create a spec file with a composite spec.

RULE - The composi te spec replaces the series spec and must come first (or second after
the metadata spec) in the spec file for the composite (or aggregate) series.

There are four steps when using X-13ARIMA-SEATS to calculate a composite seasonal adjustment.

Step 1: Create a spec file for each component series
Step 2: Create a spec file for the composite series
Step 3: Create a metafile for the component and composite series

Step 4: Run X-13ARIMA-SEATS

18



In our Building Permits example, Building Permits for the Northeast, Midwest, South and West are summed for
the total for the U.S.

Step 1 - Create spec files for the component series
Create spec files called nebp.spc, mwbp.spc, s_bp.spc, and w_bp.spc.

The spec files for the individual regions need to tell X-13ARIMA-SEATS how to combine the series. In this case,
we want to add the series, so we use the argument comptype = add. Often, the comptype argument is the
only change that we need to make from the usual spec file for the series. If you are creating a spec file with Win
X-13, add this argument to the spec file by selecting the proper option from the ‘How should the series be
combined into the aggregate?’ box in the ‘Seasonal Adjustment’ tab.

All component series must have the same starting and ending dates. If they are not the same, include a span
argument in the series spec that achieves this.

To generate stability diagnostics for the indirect seasonal adjustment, set the same length of the sliding spans and
the same start date of the history diagnostics for all component series and for the composite series. If a nondefault
value is needed for the number of sliding spans it should be set in for every component series and for the
composite series as well.

Example 11 - Spec file for Northeast (nebp.spc)

series {
title = "Northeast Building Permits”
file = "nebp.ori™
format = "datevalue”

name = "NEBP"
comptype = add
span = (1988.1,)
}
transform{ function=log }
arima{model=(0 1 1)(0 1 1)}
regression { aictest=td }
outlier{ }
forecast{ maxlead=24 }
estimate{ print=(default +rcm +acm +rts) savelog=all }
check{ print=all savelog=all }
x11{ seasonalma=s3x5 savelog=all }
slidingspans{ length=96 savelog=pct }
history{ start=2000.Jan estimates=(sadj sadjchng) savelog=(asa ach) }

Step 2 - Create a spec file for the composite series

Win X-13 can create a spec file for the composite series. Select 'Create a parent spec for a composite adjustment’
from the 'Data’ tab, and enter the full path and file name, along with the .spc extension, of the new composite spec
file in the appropriate box.

Store the spec file for the total as usbp.spc.
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Example 12 - Spec file for Total U.S. (usbp.spc)

composite {
title = "Total U.S. Building Permits"
savelog=all

}

transform{ function=log }

arima{model=(0 1 1)(0 1 1)}

regression { aictest=td savelog=aictest}

outlier{ }

forecast{ maxlead=24 }

estimate{ print=(default +rcm +acm +rts) savelog=all }

check{ print=all savelog=all }

x11{ savelog=all }

slidingspans{ length=96 savelog=pct }

history{start=2000.Jan estimates=(sadj sadjchng) savelog=(asa ach iaa)}

Note: For a composite (aggregate) series, the x11 or seats spec controls the direct seasonal adjustment of the
series. Modeling options in this spec file apply to the composite series only. The composi te spec controls
print, save, and savelog options for the indirect adjustment. The x11 spec controls print, save, and
savelog options for the direct adjustment. In this example, we used several automatic selection options, but for
a production setting, we recommend hard-coding the regression model and seasonal adjustment filters.

Step 3 - Create a metafile for the component and composite series

Create the metafile totbp.mta with the following five lines:
nebp
mwbp
s_bp
w_bp
usbp

RULE — List the spec file for the composite series last in the metafile.
Step 4 — Run X-13ARIMA-SEATS

Run the metafile like any other metafile. The program stores the output for both the direct and indirect
adjustments in usbp.out. Diagnostics for all the series are in the file totbp.log.

6. Other X-13ARIMA-SEATS Specs
Highlights of specs and additional options not described above include:

estimate - Allows you to:
e Obtain more information about the properties of model parameter estimates.
e Store the estimated model.
e Recall a stored model.

identi Ty - Produces autocorrelation function (ACF) and partial autocorrelation function (PACF) plots for all
combinations of specified orders of differencing (useful for choosing appropriate orders of differencing and
ARMA model orders). Use the ‘ARIMA Model’ tab of the Create Spec window to include this spec.
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metadata - Writes information to the diagnostics file. Users can specify any text to save, such as the name of
the spec file creator, the date the spec file was last reviewed, etc. Use the ‘Metadata’ tab of the Create Spec
window to include this spec.

regression - Specifies user-defined regression variables in addition to the regression variables included in the
program. For example, use the regression spec to include user-defined Chinese New Year or Ramadan moving
holiday regressors. See Appendix B for information on Win Genhol, a program to help create such regressors.
The “User Regressors’ tab of the Create Spec window allows you to add them to the regression spec.

transform - Transforms the series (by subtraction or division, generally) before regARIMA modeling and
seasonal adjustment. Built-in options include a length-of-month (1om) or length-of-quarter (loq) and a leap year
(Ipyear) adjustment. Add these in the ‘Customize Spec Arguments’ screen, using the adjust argument. You
can supply your own transformation via an external file; use the Create Spec screen and the ‘Prior Adj File’ tab.

Many other options are available in X-13ARIMA-SEATS. The X-13ARIMA-SEATS Reference Manual (U. S.
Census Bureau 2016a and 2016b) gives details on all the options.
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Appendix A - Alternative Options for Some Occasional Situations
Options to Run X-13ARIMA-SEATS As If It Were X-11

To run X-13ARIMA-SEATS as if it were X-11 (no forecasting, no regARIMA models, and no outlier
identification), you need only two specs: series and x11.

Example A.1 — A multiplicative "X-11 only" run for a monthly series

series{
file=""datal.dat"
start=1981.1

title="Example of Multiplicative X-11"

}
x11{ }

Example A.2 — An additive run "X-11 only" for a monthly series

series{
file=""datal.dat"
start=1981.1

title="Example of Additive X-11"

}
x11{ mode = add }

To make the program choose between the additive and multiplicative seasonal adjustment modes, include the
transftorm spec:

Example A.3 — A monthly series in "automatic X-11 only" mode
series{

file=""datal.dat"
start=1981.1

title=""Example of Automatic Transformation"

transform { function=auto }

x11 { }

Options to Run X-13ARIMA-SEATS for Forecasting Only
To use the regARIMA modeling features of X-12-ARIMA but not seasonally adjust your series, you need the

following specs, series, transform, automdl (or arima), regression, outlier,and
forecast. For diagnostics, you may also want the identify, estimate, and check specs.

22



Example A.4 widens the prediction intervals of the 24 forecasts from 95% (the default) to 90% and saves the
forecasts and the prediction intervals.

Example A.4 — An X-13ARIMA-SEATS spec file that forecasts only

series{
file=""datal.dat"
start=1981.1

title="Example with Forecasts"

}

transform{ function=auto savelog=atr }

automdl { savelog = amd }

regression { aictest=(td Easter) savelog=ats }
outlier { }
forecast {

maxlead = 24

probability=0.90

save = fct

}

estimate { print = (roots rcm acm) }
check { print=all savelog=Ilbg }

Options to Run X-13ARIMA-SEATS for Short Series

For short series, you may want to consider some alternatives. For example, it is difficult to select a good ARIMA
model with less than 60 points, so for quarterly series of less than 15 years or monthly series of less than five
years, you might want to specify an airline model instead of using the automatic modeling procedure. In addition,
the series might not be long enough for the sliding spans and history diagnostics.

Example A.5 — Example X-13ARIMA-SEATS spec file for short series

series{
file=""short.dat"
start=1981.1

title="Example Short Series"

transform{ function=auto }

arima { model = (01 1)(0 1 1) }

outlier { }

forecast { maxlead = 12 maxback = 12 } #lLong fore/backcasts not advised
estimate {print = (roots rcm acm) }

check { print=all }

x11 { }

Options to Run X-13ARIMA-SEATS Using a Single Spec File for Multiple Series

You can use a data metafile to run multiple series with the same spec file. A data metafile is a list of data file
names including the file extensions; it has a .dta extension. You can create one with Win X-13 by selecting ‘Data
Metafile’ from the Create menu on the main screen.
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The spec file used for these data files cannot have a Fi le or data argument. You can create one with Win X-13
by selecting ‘Create a single spec to adjust all series in a data metafile’ from the ‘Data’ tab of the Create Spec
screen. To run, double click on the data metafile. A screen will appear asking you to select the spec file to use.
The resulting output files are similar to those of running a regular metafile. Data metafiles are primarily for
research when wanting to use the same settings for all series; we recommend against using data metafiles to
produce official adjustments.

Options to Run X-13ARIMA-SEATS for Alternate Periodicities

X-13ARIMA-SEATS is generally used for adjusting quarterly or monthly series. It cannot be used to adjust series
with a period different from 4 or 12 with the x11 spec; series with a period of 2, 4, or 6 can be seasonally adjusted
using the seats spec. In addition, a trend component can be estimated for annual series with a seats spec. This
program cannot adjust weekly or biweekly series. The program can model and forecast series of other
periodicities, such as annual series.

A couple of examples follow.

Example A.6 — Spec file for annual data

series{
title="Example with Annual Data"
file="data3.dat" format="datevalue"
start=2001
period=1}
transform{ function=auto }
regression{ } # This is a place holder where you can enter
# regressors for any detected outliers
outlier{ }
automdl{ }
forecast{ maxlead=2 }
estimate {print = (roots rcm acm) }
check{ print=all }

Example A.7 — Spec file for a model-based seasonal adjustment of a bimonthly series

Series { Title="Model-based adjustment of Bimonthly exports"
Start = 1995.1 File = "Xports6.0ri'" Period = 6 }
Transform { Function = Log }
Regression{ } # This is a place holder where you can enter
# regressors for any detected outliers
Arima { Model = (01 1)(0 1 1) }
Outlier { types = (ao Is tc) }
Forecast { Maxlead = 18 }

Seats { save = (S11 S10 S12) }
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Appendix B - Useful Utilities When Running X-13ARIMA-SEATS

X-13-Data (Czaplicki, 2015a) converts time series data stored in Excel spreadsheets into a format that X-
13ARIMA-SEATS can read. It can also convert X-12-ARIMA and X-13ARIMA-SEATS input and output files to
Excel.

This program is available to download at:

http://www.census.gov/srd/mwww/winx13/winx13 down.html#x13datadown

Documentation is available online at

http://www.census.gov/srd/www/winx13/X13DataDoc.html

The Win Genhol (Czaplicki, 2015a) program creates holiday regressors using the same procedure as X-
13ARIMA-SEATS uses to create regressors for the U. S. holidays of Easter, Labor Day, and Thanksgiving.
Users can generate separate regressors for the effect in intervals before and after-holidays, as well as an
intermediate effect around the holiday. Users can specify more than one holiday, and the user can center these
regressors using either their overall means or their calendar-month means (calendar-quarter means in the case
of regressors for modeling quarterly data or calendar-bimonthly means in the case of regressors for modeling
bimonthly data).

The program serves as an interface to the Genhol utility (Monsell, 2012) that has been distributed for some
time. The stand-alone version of this utility is also available, but must be run from a command window.

Win Genhol can generate X-13ARIMA-SEATS commands that users can copy into spec files to use these
regressors in a regARIMA model for X-13ARIMA-SEATS runs. For more details on specific options for user-
defined regressors, read chapter 7.20 on the regression spec in U. S. Census Bureau (2016a and 2016c).
To download the software, access

http://www.census.gov/srd/www/genhol/genhol downloads.html

For more information, access the Win Genhol website at

http://www.census.gov/srd/www/genhol/index.html

X-13-Graph can create a variety of graphs from X-13ARIMA-SEATS graphic output files. There are two
versions of the program. The batch version runs in SAS, but users need no knowledge of SAS to run the program
(Lytras 2015a). The batch version submits a (user-selected) list of all the types of graphs to create for a list of
series to the SAS program, which produces all graphs in one run. A Windows interface is available to create the
lists of graphs and series, to allow you to select options for the graphs’ appearance and for saving the graphs, and
to run the SAS program to create the graphs (Lytras, 2015b). The Java version of X-13-Graph version is
interactive, generating every graph as it is requested (Lytras, 2013).

Download X-13-Graph Batch and X-13-Graph Java from

http://www.census.gov/srd/www/x13graph/
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Appendix C - X-11 Formats

X-11 formats are a family of formats, five of which are
e 1L -one line per year with label and year on left
2L - two lines per year with label and year on left
1R - one line per year with year and label on right
2R - two lines per year with year and label on right
2L.2 - two lines per year with labels and year on left, four digit year.

The advantage of X-11 formats is that the data have labels, so you can have more than one series inside a data file,
with different series having different labels. The labels can be at most 6 characters long (8 digits for the 2L.2
format) and are left justified.

The disadvantage of using X-11 formats is that if the series have real zero values at the beginning or end of the
series, X-11 formats can be difficult to work with because they treat zeros at the beginning or end of the series as
"zero filled." By default, the X-13ARIMA-SEATS program ignores the zeros at the beginning or end of the
series. To include zeros at the end or beginning of the series, set trimzero = yes in the series spec, and
specify the ending or beginning date of the series in the span argument.

The series values are stored in 6 or 12 character fields (11 characters for 2L2), depending on whether one or two
lines per year are used. No space is required between values. Except for 2L2 format, only the final two digits of
the year denote the year of the observations. By default, X-13ARIMA-SEATS assumes that any year read from an
X-11 format that is less than or equal to 45 occurs in the 21 century; otherwise, the year is assumed to occur in
the 20™ century.

Example C.1 shows a series spec that uses an X-11 format. Examples C.2 - C.5 show various X-11 formats.
Because X-11 formats include dates, do not use a start argument with them. However, a name argument is
required because each file can contain more than one series.

RULE - When using an X-11 format, a name argument is required to identify the series in the
data file. This is one place where X-13ARIMA-SEATS is case sensitive. The value of the name
argument and the label in the data file must match exactly.

Example C.1 - Series spec with a i le argument and an X-11 format

series{
file = "test2L.dat" format = "2L"
name = "BPMW-1""

3

Example C.2 - The end of a sample "1L" data file

BPNE-182 1655 1831 4822 6161 6215 6290 5955 6108 6786 7591 7188 5126
BPNE-183 3668 3433 8179 9192 11740 12959 11517 12245 11446 11078 9092 7775
BPNE-184 5194 6943 10543 13778 16303 14832 13536 13977 12104 13770 11212 9019
BPNE-185 8131 8202 13432 17997 18648 16198 16045 17199 15274 17376 14357 10643
BPNE-186 8801 7878 14636 22438 20963 21133 21980 18938 20365 19451 14071 13107
BPNE-187 9049 10666 18194 20513 19193 21060 20124 16366 17221 16110 13410 12092
BPNE-188 7889 8394 18461 16120 17646 18207 15174 15871 13803 13676 11432 9352
BPNE-189 8070 6871 10754 13980 14084 13307 10763 12357 10995 10726 9581 8181

26



Example C.3 - A piece of a sample ‘2L’ data file with the end of one series and the beginning of another series

BPNE-194 4_476 4.773 8.776 11.018 12.840 13.323
12.752 11.904 10.544 10.209 9.778 8.686

BPNE-195 6.180 4.700 8.782 9.547 10.985 10.569
9.418 10.559 9.395 9.753 8.030 6.627

BPNE-196 4.497 5.424 8.893 10.937 11.757 10.699
11.061 10.594 9.646 9.989 8.334 6.988

BPNE-197 6.050 5.666 8.588 10.075 10.623 10.446
10.803 9.492 9.754 0 0 0

BPMW-182 1.418 1.666 4.293 6.420 6.883 7.102
6.319 6.939 7.679 7.692 6.682 4.503

BPMW-183 3.432 4.630 9.927 11.236 13.477 14.340
11.716 12.488 11.435 11.003 8.831 4.929

BPMW-184 4.918 7.039 9.530 13.670 15.348 13.601
11.607 11.489 9.810 10.839 8.485 5.180

Note: The end of the series is zero-filled. By default, the program ignores the zeros at the beginning or end of the
series.

Example C.4 - The end of a sample '1R' data file

6.620 6.637 9.982 9.42110.361 9.846 8.765 8.417 6.848 8.385 6.490 4.69990BPNE-1
3.695 3.858 6.418 9.453 9.729 9.261 9.134 9.261 7.990 9.836 7.254 5.90891BPNE-1
5.439 5.528 9.04310.29910.75110.98810.633 9.760 9.634 9.949 8.880 7.56492BPNE-1
5.957 5.860 7-85910.31510-87511.61510.73210.48810.93411.265 9.549 8.29993BPNE-1
4.476 4.773 8.77611.01812.84013.32312.75211.90410.54410.209 9.778 8.68694BPNE-1
6.180 4.700 8.782 9.54710.98510.569 9.41810.559 9.395 9.753 8.030 6.62795BPNE-1
4.497 5.424 8.89310.93711.75710.69911.06110.594 9.646 9.989 8.334 6.98896BPNE-1
6.050 5.666 8.58810.07510.62310.44610-803 9.492 9.754 97BPNE-1
Example C.5 - A piece of a ‘2L.2' data file:
Ex2L2mo 1992 5439. 5528. 9043. 10299. 10751. 10988.

10633. 9760. 9634. 9949. 8880. 7564.
Ex2L2mo 1993 5957. 5860. 7859. 10315. 10875. 11615.

10732. 10488. 10934. 11265. 9549. 8299.
Ex2L2mo 1994 4476. 4773. 8776. 11018. 12840. 13323.

12752. 11904. 10544. 10209. 9778. 8686.
Ex2L2mo 1995 6180. 4700. 8782. 9547. 10985. 10569.

9418. 10559. 9395. 9753. 8030. 6627.
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